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AGENDA
• CodeWarrior Development Studio

• Introducing the LS2085A RDB

• Preparing the environment

• RDB-LS2085A with SDK EAR6.0

• Summary of CodeWarrior Software Analysis features

• Trace Compass

• Logging via DebugPrint

• U-boot tracing

• Linux user application tracing

• Linux trace – view results

• Smart filtering (tracepoints, ranges, modules)

• Summary
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CODEWARRIOR

DEVELOPMENT 

STUDIO
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Layerscape LS2085A Software and Tools Enablement

Software

Development Tools

JTAG Run Control
and Trace Probes

QorIQ 
Linux SDK

Performance 
Analysis 

and Trace Tools

QorIQ SoC 
Platform 

Configuration 
Tools
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CodeWarrior Development Studio  
A Complete Development Environment Under Eclipse

• Eclipse IDE

−Configuration Wizards

−Plug-In Architecture

−3rd party community

• Build Tools
−C/C++ Compiler

• Initialization Tools
−SOC platform initialization 

& configuration

• Run Control 
−CW-TAP

• Debugger
−Multicore aware

−Cross-triggering

Run/Stop of targets 
simultaneously

−Access to all on-chip resources

−Linux awareness

• Software Analysis -
Trace & Profile
−Leverages chip capabilities

Profiling Unit

 In system trace buffering

−Trace / Code / Performance 
Viewer

−Offline trace visibility
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CodeWarrior Aids Debug Through Multiple Phases

• Non-intrusive debug through trace

−Core and SoC trace sources: configuration, extraction, visibility

−Post-mortem debugging: offline trace

−Debug-print

−Linux aware trace

−Linux application trace

−Code Coverage
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Linux® Services

Integration 

Services

Development Tools

Solutions 

Reference

Runtime Products

Software Products and Services Visit us in the Tech Lab – #247 

Deliver Commercial 
Software, Support, 
Services and Solutions

Create Success!

Simplify Software 
Engagement with NXP

Find us online at www.nxp.com/networking-services

Accelerate Customer 
Time-to-Market

• Security 

Consulting

• Hardened 

Linux

• IOT 

Gateway

• OpenWRT+

• CodeWarrior
• VortiQa Software 

Solutions

• Commercial 

Support
• Performance Tuning
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INTRODUCING THE 

LS2085A RDB
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RESET

LS2085A RDB
Top View

u

JTAG

LS2085A

Power

Serial

Aux Ethernet is plugged into PCIe
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QorIQ LS2085A TraceIP Block Diagram
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Debug Features

• Run-Control debug features in cores

−Cross-triggering between cores

• Trace

−Program trace (ETM)

−System trace (STM)

−Stored in internal memory or DDR

No external export via TPIU or Aurora

• EPU Performance Monitor
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PREPARING THE 

ENVIRONMENT
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Connections

USB<->Serial

JTAG (take off lid)

Aux Ethernet

Cross-over 

Ethernet
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Items That Have Been Setup For You

• Host OS

−Best to use Linux on the host when developing Linux on the target

−Multiple Linux OS supported

−64-bit Linux required

−Used Mint 17.1 for class

• CodeWarrior for Networked Applications v2016.01

−CodeWarrior for Layerscape ARMv8 ISA

• QorIQ Linux SDK for LS2085A RDB

−Installed from ISOs – could also obtain from GIT

 Layerscape2-SDK-AARCH64-IMAGE-20150515-yocto

 Layerscape2-SDK-SOURCE-20150515-yocto

−Did not use CACHE

−Added extensions for tracing support
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Items That Have Been Setup For You

• Install on host

−Yocto

−Minicom / cutecom

 115200-8-N-1

−Tftp server (not used in class)

−telnet / putty (not used in class)

• Read RDB Quickstart Guide!

• Bitbake the SDK

• Install on target

−Flash U-boot
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Class Information

• Linux Login

−User: class

−Password: codewarrior

• SDK is installed in ~/SDK

−Need to use full path in tool: /home/class/SDK

• On desktop

−Launcher to Codewarrior – looks like rocket

−shortcut to cutecom

−Menu has link to terminal

Use for launch minicom

• No password on target Linux
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RDB-LS2085A
SDK EAR6.0 Installed on LS2085A RDB
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U-Boot Startup Messages

• Reset the RDB-LS2085A, interrupt the countdown

• Review the u-boot output in the console window:

U-Boot 2015.10LS2085A-SDK+g3242b20 (Mar 21 2016 - 13:23:23 +0200)

SoC:  LS2085E (0x87010010)
Clock Configuration:

CPU0(A57):1800 MHz  CPU1(A57):1800 MHz  CPU2(A57):1800 MHz  
CPU3(A57):1800 MHz  CPU4(A57):1800 MHz  CPU5(A57):1800 MHz  
CPU6(A57):1800 MHz  CPU7(A57):1800 MHz  
Bus:      600  MHz  DDR:      1866.667 MT/s     DP-DDR:   1600 MT/s

Reset Configuration Word (RCW):
00: 48303830 48480048 00000000 00000000
10: 00000000 00200000 00200000 00000000
20: 01012980 00002580 00000000 00000000
30: 00000e0b 00000000 00000000 00000000
40: 00000000 00000000 00000000 00000000
50: 00000000 00000000 00000000 00000000
60: 00000000 00000000 00027000 00000000
70: 412a0000 00000000 00000000 00000000

Model: Freescale Layerscape 2085a RDB Board
Board: LS2085E-RDB, Board Arch: V1, Board version: D, boot from vBank: 4
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U-Boot Startup Messages
DDR    15 GiB (DDR4, 64-bit, CL=13, ECC on)

DDR Controller Interleaving Mode: 256B
DDR Chip-Select Interleaving Mode: CS0+CS1

DP-DDR 4 GiB (DDR4, 32-bit, CL=11, ECC on)
DDR Chip-Select Interleaving Mode: CS0+CS1

Waking secondary cores to start from fff0b000
All (8) cores are up.
Using SERDES1 Protocol: 42 (0x2a)
Using SERDES2 Protocol: 65 (0x41)
Flash: 128 MiB
NAND:  2048 MiB
MMC:   FSL_SDHC: 0
AHCI 0001.0301 32 slots 1 ports 6 Gbps 0x1 impl SATA mode
flags: 64bit ncq pm clo only pmp fbss pio slum part ccc apst 
Found 0 device(s).
SCSI:  Net:   crc32+ 
fsl-mc: Booting Management Complex ... SUCCESS
fsl-mc: Management Complex booted (version: 9.0.4, boot status: 0x1)
e1000: 68:05:ca:36:9c:7c

DPMAC1@xgmii, DPMAC2@xgmii, DPMAC3@xgmii, DPMAC4@xgmii, DPMAC5@xgmii, 
DPMAC6@xgmii, DPMAC7@xgmii, DPMAC8@xgmii, e1000#0 [PRIME]

Hit any key to stop autoboot:  0



PUBLIC USE19 #NXPFTF

Linux

• Linux is automatically booting 

• If u-boot countdown has been interrupted, boot Linux with command “boot”

• When Linux booting is complete:

− Login with user root and no password

− Configure eth0 to 192.168.1.100

INIT: Entering runlevel: 5un-postinsts exists during rc.d purge 
Configuring network interfaces... done.
Starting OpenBSD Secure Shell server: sshd
generating ssh RSA key...
generating ssh ECDSA key...
generating ssh DSA key...

Poky (Yocto Project Reference Distro) 1.8.1 ls2085ardb /dev/ttyS1

ls2085ardb login: root
root@ls2085ardb:~# ifconfig eth0 192.168.1.100
root@ls2085ardb:~#
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SUMMARY OF CW 

SOFTWARE ANALYSIS 

FEATURES 
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Trace overview

• Based on hardware trace modules that monitor and probe core execution, system 

busses, transactions, memory accesses, peripherals activity, etc.

• Minimal to no intrusiveness to system activity and performance

• Used to investigate crash analysis

• Assembly level instruction granularity for program trace

• Multiple collection modes supported (One Buffer, Overwrite)

• Multiple storage location for trace (Internal Buffer, DDR, Scatter-Gather, external 

device)

• Ability to filter trace events directly on target, multiple combinations

• Ability to combine multiple trace sources into one single stream

• Integrated at system level with hardware triggering mechanisms
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Trace viewer screenshot Customize the view
Various trace events

from different sources
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Hierarchical Profiler overview

• Based on hardware trace 

• Calculate inclusive(self) and exclusive(hierarchical) time for functions

• Min/Max/Average analysis

• Caller/callee breakdown (hierarchy of calls)

• Code optimization – according with Pareto principle “80% of the effects come from 

20% of the causes”
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Hierarchical Profiler viewer screenshot

Caller-callee pairs

Functions 

overview

Statistics
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Code Coverage overview

• Based on hardware trace – no source instrumentation needed

• Provides coverage at assembly instruction level

• Statistics at assembly and C source line level

• Report in html format

• Decision coverage analysis at assembly instruction level
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Code Coverage viewer screenshot

Summary table

for files and functions

Coverage metrics

at assembly and source level

Coverage details

with asm decision coverage
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Call Tree overview

• Based on hardware trace

• Identifies the longest calls path (critical path)

• Shows the max stack size (simulator)

• Investigate a certain flow
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Call Tree viewer screenshot

Critical call chain

longest call stack
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Timeline overview

• Based on hardware trace

• Analyze execution flow

• Spot performance problems in code and bottlenecks

• Easily see out-of-order execution

• Understand the context of a certain execution error

• Logic analyzer look and feel

• Ability to group multiple functions to a single entry (e.g., module, unit)

• Customize the colors
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Timeline viewer screenshot
Execution flow

at glance

Markers

for fast measurements

Change colors

for better visibility



PUBLIC USE31 #NXPFTF

TRACE COMPASS
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Linux Tools – LTTng

• Linux Trace Toolkit – next generation: kernel and user-space 

tracer with view and analysis tools.

• LTTNG has been separated out of the Linux Trace Toolkit.  

Now a separate project called Trace Compass.

− http://projects.eclipse.org/projects/tools.tracecompass

http://projects.eclipse.org/projects/tools.tracecompass
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LTTNG

• Trace Compass is a Eclipse tool for viewing and analyzing any type of logs 
or traces. 

− Provide views, graphs, metrics, etc. to help extract useful information from traces, 
in a way that is more user-friendly and informative than huge text dumps

• Eclipse: “LTTng Kernel” perspective 

• View the results

− Events: timestamp, trace, Marker, Content

− Histogram: trace event distribution in time

− Control flow: processes list and their state in time

− Resources: CPU  resources per interrupts type

− Statistics: event counters cpu time, cumulative /elapsed time

• Import or create a LTTng trace
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Traces / Logs

• Trace Compass supports many trace formats:

− Common Trace Format (CTF), including but not limited to: 

 Linux LTTng kernel traces

 Linux LTTng-UST userspace traces

 Linux Perf traces (using the out-of-tree patchset to convert to CTF)

− GDB traces for debugging

− The libpcap (PAcket CAPture) format, for network traces

http://www.efficios.com/ctf
https://lttng.org/
https://lttng.org/ust
https://lwn.net/Articles/634333/
https://sourceware.org/gdb/onlinedocs/gdb/Tracepoints.html
http://wiki.wireshark.org/Development/LibpcapFileFormat
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Linux Trace

• Static probe points strategically located inside the kernel 
code 

• Register/unregister with tracepoints via callback mechanism 

• Can be used to profile, debug and understand kernel 
behavior 

• Trace synchronization

− Time correction

− Multi-core

− Dependency analysis, delay analyzer

− Dependencies among processes
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ACTIVITY
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Trace Compass – new RSE connection

1. Open Remote Systems view (Window->Show View->Other->Remote Systems->Remote Systems)

2. Create a Linux based RSE connection

New RSE connection

SSH with SCP
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Trace Compass – new RSE connection

3. Follow the steps to create the RSE connection over SSH

IP of target

Name the connection

class
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Trace Compass – new RSE connection

4. Continue to follow RSE connection creation wizard
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Trace Compass – new RSE connection

5. Right-click on Ssh Shells -> Properties -> Subsystem. Verify the 

port (default is 22; change if port is forward). Set root as user ID.
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Trace Compass – new RSE connection

6. Now expand the Scp Files node and you will be able to browse the 

target file system:
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Trace Compass – trace session

1. Open a Terminal over a RSE connection from CodeWarrior (right-click on RSE tree and 
LaunchTerminal)

2. Load LTTng modules:

modprobe lttng-tracer

3. Check that LTTng modules are loaded:

lsmod

4. Create a new LTTng session:

lttng create ftfSession

5. Enable all events for Kernel tracing:

lttng enable-event --kernel --all

6. Start tracing session:

lttng start

7. Run some applications (e.g., ls, top)

8. Stop tracing session:

lttng stop

9. Destroy session:

lttng destroy
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Trace Compass – trace session

10. Notice the newly created folder in your home dir (lttng-traces)

11. Copy the session folder like this:

12. Paste in Local node (RSE):

Copy … from 

this directory

Paste … to 

this directory
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Trace Compass – trace session

13. Open Project Explorer view

14. Right-click and choose Import

15. Select Tracing->Trace Import

Import trace
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Trace Compass – trace session

16. Choose the copied folder with trace session; check the file to 

import; select Trace Type as LTTng Kernel Trace

Select 

session file

Select Trace 

Type
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Trace Compass – trace session

17. Open LTTng Kernel perspective

18. Double-click on imported trace session from Project Explorer 
view (kernel entry):

19. Various views will open and you can explore trace results

Double-click 

on kernel 

entry
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Trace Compass views

Control Flow

CPU Usage
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Trace Compass views

Histogram

Events
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Trace Compass views

Resources

Statistics

Project Explorer – Trace 

Compass session
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LOGGING VIA 

DEBUGPRINT
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Introduction to ODP

What is ODP?
• The OpenDataPlane (ODP) project has been established to produce an

open-source, cross-platform set of application programming interfaces (APIs)

for the networking data plane

• ODP provides a data plate application programming environment that is easy

to use, high performance and portable between networking SoCs
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Introduction to ODP Reflector Application

It’s a sample application which performs several functions:
 Received scheduled packets are reflected back onto the same interface where the packets were 

originally received

 The source and destination MAC and IP addresses are swapped in received packet

 Works for all Ethernet interfaces that are defined in the resource container used by the application

 Multiple threads can be spawned for each network interface for I/O operation. In multicore environment, 

threads are affined with multiple cores. For single core environment, all threads are affined with the 

same core

Application is supported for two modes as given below:

a) Schedule PULL mode – 0 : Scheduled packets are received in PULL Mode

b) Schedule PUSH mode – 1 : Scheduled packets are received in PUSH Mode

Mandatory OPTIONS

-i, --interface Eth interfaces (comma-separated, no spaces)

-m, --mode

0 – Receive packets in Schedule PULL mode

1 – Receive packets in Schedule PUSH mode

Optional OPTIONS

-c, --count <number> CPU count

-h, --help Display help and exit
Spirent Test 

Center

DUT

odp_reflector

dpni-1

dpni-2

Interface#1

Interface#2
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ODP reflector – Hardware setup using only one board

For full details and steps describing the hardware and software setup please check AN5269

LS 2085A-RDB

TCP/IP over Eth link

No Debug Probe

Host PC running 

CW ARMv8 

Loopback
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ODP reflector – software configuration
After you’ll get a linux prompt, you need to issue next commands:

root@ls2085ardb:~# ifconfig ni0 6.6.6.1 up

root@ls2085ardb:~# arp -s 6.6.6.10 000000000006

root@ls2085ardb:~# ifconfig eth0 192.168.1.2 

root@ls2085ardb:~# /usr/odp/scripts/dynamic_dpl.sh dpmac.6

...

dprc.2 Created

dpmac.6 <--------connected------> dpni.1 (00:00:00:00:0:6)

USE  dprc.2  FOR YOUR APPLICATIONS

root@ls2085ardb:~# restool dpni info dpni.0

endpoint: dpmac.5, link is up

root@ls2085ardb:~# restool dpni info dpni.1

endpoint: dpmac.6, link is down

root@ls2085ardb:~# export DPRC=dprc.2

root@ls2085ardb:~# /usr/odp/bin/odp_reflector -i dpni-1 -m 0 -c 8 &

Initializing NADK framework with following parameters:

Resource container :dprc.2

…

setup_pkt_nadk 55-NOTICE-port =>  dpni-1 being created

setup_pkt_nadk 66-NOTICE-setup FQ 0

Port dpni-1 = Mac 00.00.00.00.00.06

<enter>

root@ls2085ardb:~# tcpdump -i ni0 &

<enter>

root@ls2085ardb:~# ping 6.6.6.10 -c 1

13:40:10.060171 IP 6.6.6.1 > 6.6.6.10: ICMP echo request, id 1953, seq 1, length 64

13:40:10.060207 IP 6.6.6.10 > 6.6.6.1: ICMP echo request, id 1953, seq 1, length 64

13:40:10.060229 IP 6.6.6.1 > 6.6.6.10: ICMP echo reply, id 1953, seq 1, length 64

13:40:10.060247 IP 6.6.6.10 > 6.6.6.1: ICMP echo reply, id 1953, seq 1, length 64

Linux Container

ni0 (6.6.6.1)

Copper port – eth1

dpni.0

dpmac.5

Copper port – eth0

dpni.1

dpmac.6 

(000000000006)

ODP Container

Loopback

1
2

4

A

7

8

6

3

5

1. Set ip to ni0 interface used for Linux Container

2. Add arp entry – all traffic to 6.6.6.10 will be redirect to 

dpni1 (which dmpac.6 – 000000000006)

3. Set ip to eth0 interface used by communication with CW

4. Allocate a new dpni (dpni.1) to dpmac.6 using restool via 

dynamic_dpl.sh utility script

5. Set the ODP container

6. Start the odp_reflector on dpni-1 in PULL mode

7. Start tcpdump to inspect the reflected traffic

8. Start the traffic using a single ping packet

A. Req packet from Linux Container to ODP Container/Reflector

B. The reflector will reflect back the same req packet swapping the IP 

src/dst

C. For the above received req packet, the Linux Container will send 

an echo reply packet

D. The linux networking stack sends the echo 

reply for the first req packet (A)

“6.6.6.10” (traffic sent 

here via arp entry)

Auxiliary steps

B
C

D

A

B
C

D
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Debug Print – Fundamentals

Debug Print provides an easy method for checking Kernel & 

Application activities.

Debug Print consists in:
− Server side: running on target Linux OS for collecting Kernel Ring Buffer logs and 

application messages to standard output;

− Client side: running under CW for getting data out of the server, display and various 

configurations

Client for ls.target.server

TCP/IP over Eth

No Debug Probe

Linux OS running on 

LS 2085A-RDB

ls.target.server – reads logs 

and sends log data over TCP/IP

libls.linux.debugprint.lib.so –

redirect user space application 

messages to ls.target.server

Server side

CW ARMv8 running 

on Host PC

Debug Print Viewer
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ACTIVITY
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Server Side: setup

Using RSE all Debug Print Server utilities can be copied directly into the target Linux OS via 
“Add Debug Print Support” (scp connection-> /usr/odp/scripts)

linux.armv8.debugprint

folder is created with all the prerequisites
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Server Side: setup (cont’d)

Starting the server: ls.target.server [PORT] [-k]

PORT : default 5000

-k : it does not clear the kernel buffer, but uses an 

internal server logic for determining which are the 

newer messages

E.g.: starting the Debug Print server with default settings

root@ls2085ardb:/usr/odp/scripts#./linux.armv8.debugprint/bin/ls.target.server & 
Using port 5000
Using Kernel Ring Buffer
Initializing
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Client Side: setup

Open the Debug Print Viewer and connect the Client with the 

Server using TCP/IP and Port

1

2

3

Start/Stop

Client

Custom 

filter

Clear 

console

Scroll 

lock/unlock
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Client Side: Debug Print messages format

Entry format:

Entry MSG Type Timestamp MSG Source MSG Body

EMG - emergency /* system is unusable 

ALT - action must be taken immediately

CRT - critical conditions

ERR - error conditions

WRN - warning conditions

NOT - normal but significant condition 

INF - informational

DBG - debug-level messages

KERNEL

Kernel MODULE 

USER SPACE APPLICATION
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Reflector: startup

Step 1: setup the environment according with reflector requirements:

Step 2: Debug Print client will catch all logs during setup:

root@ls2085ardb:/usr/odp/scripts/dynamic_dpl.sh dpmac.6
dpcon.1 assigned to  dprc.2
dpcon.2 assigned to  dprc.2
dpcon.3 assigned to  dprc.2
dpcon.4 assigned to  dprc.2
dpcon.5 assigned to  dprc.2
dpseci.0 assigned to  dprc.2
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Reflector: startup (cont’d)

STEP3: redirect reflector standard output to Server by loading the 

appropriate library and start the application:

At this point the Linux console should look like: 

root@ls2085ardb:/usr/odp/bin/# 
LD_PRELOAD=/usr/odp/scripts/linux.armv8.debugprint/lib/libls.linux.debugprint.so.1.0 
/usr/odp/bin/odp_reflector -i dpni-1 -m 0 -c 8

odp_nadk_scan_device_list 192-NOTICE-dpconc-2 being created
odp_nadk_scan_device_list 192-NOTICE-dpconc-1 being 
createdodp_schedule.c:160:odp_schedule_init_global():Schedule init ... 
odp_schedule.c:214:odp_schedule_init_global():done

odp_nadk_scan_device_list 192-NOTICE-dpni-1 being 
createdodp_crypto.c:1153:odp_crypto_init_global():Crypto init ... 
odp_pool.c:236:odp_pool_create():Configuring buffer pool list 
0x32a05c00odp_pool.c:368:odp_pool_print():NADK BMAN buffer pool bpid
4odp_packet_io.c:239:odp_pktio_open():Allocating nadk pktio
odp_packet_nadk.c:45:setup_pkt_nadk():setup_pkt_nadk

setup_pkt_nadk 55-NOTICE-port =>  dpni-1 being created
setup_pkt_nadk 66-NOTICE-setup FQ 0odp_schedule.c:345:odp_schedule_queue():setup VQ 0 
with handle 0x41

root@ls2085ardb:/usr/odp/bin/# export DPRC=dprc.2
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Reflector: Debug Print results

Reflector application messages

new Kernel messages are catch
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Reflector: Debug Print results (cont’d)

Customize the Debug Print 

Client to display only 

relevant information: 

messages for reflector
1

2
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Debug Print Considerations

• Debug Print Client can show up messages from Kernel, Modules 

and User Applications in a easy straightforward fashion allowing 

filtering based on source/timestamps/keywords

• Attaching like use cases to a running application is not supported 

since the Debug Print redirect library must be loaded before 

application is getting started

• Debug Print Server and Client can be started at any time
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U-BOOT TRACING
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U-Boot tracing

- Perform trace on u-boot execution

- Catch u-boot stages, before and after code relocation

- No hassle for users with trace buffer for each stage

- Integration with Debugger for proper injection of trace settings when code relocation is done
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1. Open “Trace and Profile” tab. Make a new platform configuration – make sure that you 

choose the right platform architecture -> LS2085A

2. Enable only the Core#0 trace

3. Enable Timestamp and U-boot scenario

4. Add u-boot binary for Core#0

U-Boot tracing – setting Trace configuration

Settings
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U-Boot tracing – launching u-boot project

5. Press on “Debug” button to launch the project

6. Target will stop at address 0x00000000

7. Open Trace Commander view (Window -> Show View -> Other -> Software Analysis)

Make sure that the right platform config is used:

Platform config
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U-Boot tracing – running u-boot project

8. Press on Connect button to apply trace settings on target

9. After connection is done, resume execution of target (you may notice into a terminal linked 

with target serial connection)

10. After u-boot was executed (see in terminal when u-boot is done), suspend target 

execution from CodeWarrior

11. Collect trace from Trace Commander view

Collect trace by pressing this button
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U-Boot tracing – see results

12. Open Analysis Results view and refresh it to display the new collected data

13. Open Trace, by clicking on Trace link.

14. Search for “U-Boot trace before code relocation” and “U-Boot trace after code relocation”
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U-Boot tracing – see results

15. Notice the change in timestamp and address of execution after code relocation.
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LINUX USER 

APPLICATION 

TRACING
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Linux Probe-less Trace

• Based on a software probe

−Linux cross-compiled application

−CW and SDK component

• Advantages
−Speed
 contains only what is needed

−Speed
 all services are hosted on target machine

−Nonintrusive
 no need to instrument the target application

−Simple API
 can be effortlessly integrated into any testing framework

−Data-driven
 the configurator and probe can be easily tuned up using xml files
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Linux Probe-less Trace – Hardware setup

Hardware Probe using JTAG 

(E.g. CodeWarrior USB TAP)

Ethernet cable + linux.armv8.satrace

Linux standalone application 

included in CodeWarrior and 

QorIQ SDK

LS 2085A-QDS
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Linux probeless trace – Command Line API
This application starts and collects trace on target.

Usage: ./linux.armv8-sdk1.8-ear6.satrace/bin/ls.linux.satrace [Options] app [app_args]

User space options:
-A [ --archive-file ] arg (=[app_name].cwzsa)

Archive path
-b [ --backtrace ]    Shows backtrace on SEGFAULT.

[app_name] - Name of the traced application.
Common options:

-T [ --multithreading ]  Enables multithreading support.
-p [ --pid ] PID         Attach to a process giving a PID.
--vmid vmid Virtual machine ID
--start-trace address    Start tracepoint
--stop-trace address     Stop tracepoint
--include-range range    Include range
--exclude-range range    Exclude range

Kernel space options:
-K [ --kernel ] path  Archive path.
-i [ --kernel-image ] path vmlinux image compiled with debugging symbols.

System trace options:
-S [ --system ] arg (=[app_name].scwzsa)

Archive path.
-i [ --kernel-image ] path vmlinux image compiled with debugging symbols.
-b [ --backtrace ]    Shows backtrace on SEGFAULT.

General options:
-v [ --verbose ]          Verbose mode
-V [ --version ]          Product version
-h [ --help ]             Displays this help message
-c [ --config-file ] path Configuration file
--soc arg (=LS2085A)      Name of the SoC

Notes:
Do not mix kernel and user space options, otherwise all user space options will 
be ignored.
The kernel space trace will be collected after catching the SIGINT signal 
(CTRL+C).
-A will create an archive with a custom name.

[range] - An interval specified using one of the following formats :
0x2000-0x3000                Address range [0x2000, 0x3000]
libpthread Executable code from libpthread.so
init_linuxrc Address range based on kernel function name

Covers all instructions from init_linuxrc
init_linuxrc-init_linuxrc+8  Includes/Excludes first 8 bytes from 

init_linuxrc
ipv6.ko                      Includes/Excludes 'ipv6' kernel module

[address] - An address specified using one of the following formats :
0x2000                       Hex address
libpthread+200               Offset from a shared libary (libpthread.so)
init_linuxrc Address based on kernel function name
init_linuxrc+8               Kernel function offset
ipv6.ko                      Kernel module offset

--vmid argument is compatible only with address range filters.

Examples :
ls.linux.satrace -A archive.cwzsa ./my_app
ls.linux.satrace ./my_app my_arg1 my_arg2
ls.linux.satrace -K kernelTest
ls.linux.satrace -K kernelTest -i ~/vmlinux
ls.linux.satrace -p 534
ls.linux.satrace -p 534 -A attachTrace
ls.linux.satrace -p 534 --include-range=init_linuxrc-init_linuxrc+20
ls.linux.satrace -p 534 --exclude-range=0x3000-0x7000
ls.linux.satrace --vmid=1 -S arname -p 534 --include-range=0x2000-0x3000 

--include-range=0x4000-0x5000
ls.linux.satrace -p 534 --start-trace=__switch_to

--stop-trace=__switch_to+0x200
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Linux user space application trace (command line)

User application

User process                 satrace process

fork + exec

Trace configuration

Trace collection
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ACTIVITY
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Linux probeless trace (CodeWarrior)

1. Add trace support (right click on your demo folder):

2. Right-click on RSE tree  Launch a Terminal

Added trace support

New Terminal

linux.armv8.satrace folder is 

created with all the prerequisites
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Linux probeless trace (CodeWarrior)

3. Open Project Explorer. Right-click and Create new project

4. Create a Linux Application Debug project. Build it.

New ARMv8 stationary project

New Linux Application Debug project
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Linux probeless trace (CodeWarrior)

5. Open Project Explorer. Right-click and Create new project

6. In Remote Systems view, copy elf file to demo folder

Copy elf binary
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Linux probeless trace (CodeWarrior)

7. Run ls in Terminal to check the files in your folder:

8. Launch application with trace support. Make sure you pass –v flag 

in order to see all stages in verbose mode:

./linux.armv8.satrace/bin/ls.linux.satrace -v ./ftfLinuxDemo.elf
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Linux probeless trace (CodeWarrior)

9. The results will be:
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Linux probeless trace (CodeWarrior)

10. Refresh the files system view. Notice the newly created *.cwzsa

file. Double-click on it to import trace results on host.

11. During import process, select the right binary file:

Trace results file

Binary file
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Linux probeless trace (CodeWarrior)

12. Notice the Analysis Results view in CodeWarrior. Browse the 

results and open them.
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LINUX TRACE – VIEW 

RESULTS
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Analysis Results content

Platform configuration 
used to collect trace

Data source from where the trace was collected:
 DTC

 DDR

 or Imported trace

Links
 Trace Viewer 

 Timeline 

 Code Coverage

 Hierarchical Performance

 Call Tree
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Trace Viewer

1. From results folder:

2. Open Trace Viewer:

 Accurate information about program 

flow, DDR transactions, instrumentation 

trace, NoC transactions and PCI Express 

debug status.
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Code coverage

1. From results folder:

2. Open code coverage viewer:

Split pane with 2 types of info:

 Summary table displaying 
statistics for each function

 Details table displaying 
line-by-line coverage of
selected function
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Performance profiler

1. From results folder:

2. Open performance viewer:
 Per core analysis

 Split pane with 2 types of 
information:

 Summary table displaying 
profiling values for functions
executed in each context

 Details table displaying 
performance values for 
caller and callee
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Call tree profiler

1. From results folder:

2. Open call tree viewer:

Shows call tree of executed 
functions. Two highlighted paths:

 Green color shows critical path

 Grey background shows max 
stack path
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Timeline

1. From Analysis Results view:

2. Open Timeline viewer:

 Organizes multicore results in tabs

 Customize the way the data is drawn

 Execution timeline of functions and
custom groups

 Spot performance problems in code and bottlenecks
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SMART FILTERING
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Smart filtering

There are hardware resources (e.g., comparators) available for Cortex-A57 useful to implement smart 

filtering. Those resources are available per core. Available resources are:

- 4 address comparator pairs

- 1 Context ID comparator

- 1 Virtual Machine ID comparator

With those resources, there are implemented 2 types of smart filters: tracepoints and ranges.

Tracepoints allow to start and stop trace collection.

Ranges(include range and exclude range) allow to enable trace collection inside or outside certain area.

Tracepoints are used when want to start trace collection at a certain address(e.g., after initialization 

code) or to stop trace collection after a certain address(e.g., before application printing results).

Ranges are used when want to trace always the same area, no matter how many enters or exists(e.g., a 

certain function).
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Smart filtering

- Both tracepoints and ranges allow 

flexibility in defining addresses

- It can be pure addresses, 

libraries/executables names or symbols 

names

- Offsets can be used making usage more 

user friendly

- Also there is support for tracing kernel

modules – identified by name

Usage: ./linux.armv8-sdk1.8-ear6.satrace/bin/ls.linux.satrace [Options] app [app_args]

Common options:
-T [ --multithreading ]  Enables multithreading support.
-p [ --pid ] PID         Attach to a process giving a PID.
--vmid vmid Virtual machine ID
--start-trace address    Start tracepoint
--stop-trace address     Stop tracepoint
--include-range range    Include range
--exclude-range range    Exclude range

[range] - An interval specified using one of the following formats :
0x2000-0x3000                Address range [0x2000, 0x3000]
libpthread Executable code from libpthread.so
init_linuxrc Address range based on kernel function name

Covers all instructions from init_linuxrc
init_linuxrc-init_linuxrc+8  Includes/Excludes first 8 bytes from 

init_linuxrc
ipv6.ko                      Includes/Excludes 'ipv6' kernel module

[address] - An address specified using one of the following formats :
0x2000                       Hex address
libpthread+200               Offset from a shared libary (libpthread.so)
init_linuxrc Address based on kernel function name
init_linuxrc+8               Kernel function offset
ipv6.ko                      Kernel module offset

--vmid argument is compatible only with address range filters.

Examples :
ls.linux.satrace -p 534 --include-range=init_linuxrc-init_linuxrc+20
ls.linux.satrace -p 534 --exclude-range=0x3000-0x7000
ls.linux.satrace --vmid=1 -S arname -p 534 --include-range=0x2000-0x3000 

--include-range=0x4000-0x5000
ls.linux.satrace –K kern --start-trace=__switch_to --stop-trace=__switch_to+0x200
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Smart filtering

A distinct feature is the ability to filter on VMID(Virtual Machine ID). This allow to trace only execution 

inside a certain virtual machine.

There is provided an experimental support for multithreading, in case of user space applications. This is 

related with multiple threads launched by analyzed application. There is a default mask of 256 threads 

that can be traced. Alternatively, only the main thread of application can be traced.

Smart filtering is a flexible mechanism to filter the amount of trace collected directly fro hardware, with no 

impact on application/system execution. This will greatly help on host operations(e.g., trace decoding, 

profile generation).

Currently available only command line, it could be very easily supported in CodeWarrior UI. The process 

of trace configuration is data driven and easily supports various extensions.
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SUMMARY



PUBLIC USE98 #NXPFTF

Summary

• This course has been a brief introduction into the LS2085 RDB board and the 

CodeWarrior tools available to debug the board

• Linux application tracing

• Digital Networking is introducing a new networking tools suite

−CodeWarrior Development Studio for QorIQ LS Series – ARMv8 ISA

−Tools covering Configuration, Build, Debug, and Analysis

CodeWarrior for ARMv8

Configure Build Debug
Trace 
and 

Analysis

http://www.nxp.com/codewarrior

http://www.freescale.com/codewarrior
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Q & A
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